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1 Purpose 

NLT 1 Oct 2015, the Defense Information Systems Agency (DISA) will begin enforcing size 

limits on DoD Enterprise Email (DEE) mailboxes in accordance with the Service Level 

Agreement. To ensure continued use and optimal performance of your DEE mailbox, each user 

must maintain their mailbox within its size limit. If your mailbox currently exceeds its limit, you 

will need to take actions to reduce its size to avoid a negative impact to your service.  

2 References 

Army Enterprise Service Desk Support page at https://esd-crm.csd.disa.mil/  

3 Scope 

This document applies to all Army DEE users.  Methods of mailbox size reduction are provided 

for Outlook 2007 and 2013 and the Outlook Web Application (OWA). 

4 Procedures 

This document provides steps to eliminate unnecessary email and store email locally in order to 

reduce the overall size of their DEE mailbox.  

We have a separate section for the following three possibilities: 

 Outlook 2007 

 Outlook 2013 

 Webmail (OWA) 

4.1 How to Reduce your Mailbox Size in Office 2007 

Note:  For those users who have mail in the CommVault archive, the mailbox size that is being 

used for the size limit implementation does not count anything in CommVault. 

4.1.1  Identify Current Size of Mailbox  

The first step in reducing your mailbox size is to identify the current size of your email folders.  

To identify the sizes of those folders perform the following tasks. 

a) In Outlook, click the “Tools” menu and on the drop down menu click “Mailbox Cleanup”. 

https://esd-crm.csd.disa.mil/
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Figure 1 : Right Click on Inbox 

b) On the top of the box click on the “View Mailbox Size...” box. 

 

Figure 2 : View Mailbox Size 

 

c) To identify the size of all folders, click on the “Server Data” tab and look at the Total 

Size line.  Notice that this includes all subfolders. This is important since the size of not 

only the top folder, but the subfolders as well will count against the limit.  In particular, 

pay attention to the size of the Calendar, Deleted Items, Inbox, and Junk E-Mail. 

NOTE:  When Outlook is running in Cached mode, it will store copy the mailbox in the locally 

stored OST file, for offline access. Sometimes, deleting / moving emails doesn't get 

sync'd with the server. So, your local data may look bigger (or smaller) than the 

server data.  You want to focus on the SERVER DATA because this is what mailbox 

size limit is calculated from.  
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Figure 3: Identify Total Size of Mailbox (Including Sub-Folders)    

d) In the picture above,the size of the inbox is provided in KBs (kilobytes).  Business class 

users have a 4GB (gigabyte) limit, so the total size must be less than 4,000,000 KBs.  

Basic class users have a 512MB limit, and the total size must be less than 512,000 KBs.  

IMPORTANT NOTE:  Each Outlook user is allowed to keep and store an unlimited amount of 

email, however it cannot all be stored in your mailbox.  Each user must make an assessment of 

which email must be “globally accessible” and which email only need to be accessible from the 

primary work location (i.e. the office).  Just like you can have an unlimited amount of clothing 

stored in closets at home, but only take a specific amount and type when travelling, you can 

have an unlimited amount of email stored and accessible from your office but must determine 

which email must be accessible via webmail or a mobile device so you can access it any time 

from any where.  Unlimited storage is covered in step 4.1.3 below. 

4.1.2  Easy Mailbox Cleanup Tasks 

If the total size of the folders exceeds the mailbox limit, the user must proceed with clean up 

tasks.  Prior to creating any local storage files and moving oldest (rarely/never accessed) mail 

into those files, the user can perform some easy “house cleaning” by doing the following tasks: 

 Remove attachments from your calendar 

 Empty the Sent Items, Junk E-Mail, and Deleted Items folders.  

 Sort your Inbox by size, and clean up the largest items 

These steps will be covered in detail below. These activities in-and-of themselves may provide a 

significant change in folder size, especially if they contain large attachments.   

4.1.2.1 Remove attachments from your Calendar. 

a) The simplest way to clean attachments from your calendar is to view the Calendar as 

a list and then sort the Calendar by size. 

Total Size 

includes sub-

folders (if any) 
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b) In Outlook, select the "View" menu, then select “ Current View”, then select “All 

Appointments" in the drop-down menu. 

 

Figure 4: Changing Current View to "All Appointments" 

c) In order to sort by size you need to add the size "Field" to your view by clicking on 

“View”, “Current View”, then “Customize Current View”. 

 

Figure 5: Enabling the Size Field 

d) Once the “Customize View All Appointments” box opens, select “Fields”, then on the 

“Select Available Fields From” drop down menu select “All Mail Fields.” 
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Figure 6: Selecting "All Mail fields" 

e) In the “All Mail fields” list scroll down to “Size” and select, click on the “Add” button, 

then Click on OK, the click on OK again to close. 

 

Figure 7: Adding the "Size" field 

f) Now, click on the arrow in the newly added “Size” column to sort by size (largest to 

smallest). This will sort your calendar items by file size as opposed to the date or 

time. 
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Figure 8: Sort by Size (largest to smallest) 

g) Once the calendar appointments are sorted by size, you can open the largest 

appointments and review the attachments.  Save the attachments, if desired, by 

right-clicking the attachment and choosing “Save As” and then selecting the location 

to save the file and clicking “Save”.  Whether you save the attachment or not, delete 

the attachments from the appointment and save the appointment. 

4.1.2.2 Empty Sent Items, Junk E-Mail, and Deleted Items folders. 

If these folders do not contain information of any consequence, then all the contents (of these 

folders) can be deleted.   

a) The first step in this process is to open the Sent Items folder in the left hand panel of 

Outlook as depicted below. 
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Figure 9: Open Sent Items 
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b) This will populate the center panel with emails contained in this folder.   To delete 

these items highlight the top email, click and hold the <Shift> key, then scroll down to 

the bottom of the window and click on the bottom email.  This should highlight the 

entire grouping of emails as shown below. 

 

Figure 10: Select Entire Group for Deletion 

c) Delete all of these items by clicking the <Delete> key.  If you only want to delete 

some of the items, then simply select the ones to eliminate and delete those. 

d) Repeat this same process for the Junk E-Mail folder. 

e) Lastly, repeat this process for the Deleted Items folder.  NOTE: Emails deleted from 

the Sent Items and Junk E-mail folders will be placed in the Deleted Items folder thus 

it is important to clean out the Deleted Items folder last.  
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f) With these folders cleaned up the user can check the updated size of the mailbox by 

simply clicking on “Tools”, “Mailbox Cleanup…” and “View Mailbox Size…”. 

4.1.2.3 Sort Inbox by size, and clean up the largest items. 

a) If the Size column is available in your Outlook Inbox, sort the Inbox by clicking the 

Size column header.  The direction of the little triangle indicates largest to smallest or 

smallest-to-largest.  See Figure 6 below. 

 

Figure 11: Select Size to sort Inbox by Size 

b) If the Size column is not available then arrange them by size by selecting the “View” 

menu, then choosing “Arrange By” and select “Size”.  See Figure 7 below. 

 

Figure 12: Arrange the Inbox by Size 
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c) Once the email is sorted by size, you can delete any email you no longer need. 

d) For email you want to keep, open the email and review the attachments.  Save the 

attachments, if desired, by right-clicking the attachment and choosing “Save As” and 

then selecting the location to save the file and clicking “Save”.  Whether you save the 

attachment or not, delete the attachments from the email and save the message.   

e) If you don’t want to keep the email but need the attachments, open the email and 

save the attachments.  Right-click the attachment and save, then delete the 

message.  

f) Once attachments are saved and unnecessary email deleted, remember to go back 

and empty the Deleted Items folder (because email deleted from the Inbox is now in 

your Deleted Items folder).  

4.1.3  Create an Outlook .pst file 

If, after the Calendar, Sent Items, Junk E-Mail, and Deleted Items folders have been cleaned 

out, you have saved attachments and deleted unnecessary email from your Inbox, and the 

mailbox is still over the size limit, you can leverage the use of .pst files (personal folders) to 

store an unlimited amount of email locally. 

IMPORTANT NOTE:  Each Outlook user is allowed to keep and store an unlimited amount of 

email, however it cannot all be stored in your mailbox.  Each user must make an assessment of 

which email must be “globally accessible” and which email only needs to be “locally accessible” 

from the primary work location (i.e. the office).  Just like you can have an unlimited amount of 

clothing stored in closets at home, but only take a specific amount and type when travelling, you 

can have an unlimited amount of email stored and accessible from your office but must 

determine which email must be accessible via webmail or a mobile device so you can access it 

any time from any where.  To clarify this concept, your mailbox is your suitcase and your 

personal folders (.pst files) are your closets (and can be located on local drives or shared 

drives).  

According to email usage statistics, most people very rarely access anything over 6 months old.  

The best business practice is to move email older than 6 months into a personal folder.  This 

does three important functions: 

 It keeps the user’s most important email globally accessible, while still retaining all email 

and making it all available when in the primary work place. 

 It keeps the Outlook mailbox trimmed and manageable, resulting in fast and responsive 

performance for the user. 

 It provides an easy option for a user to retain/save all email the user wants to keep for 

an indefinite period of time. 

To continue with this process follow the steps as described below: 

a) Open Outlook 2007  
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b) On the File menu, point to New, and then click Outlook Data File 

 

Figure 13: Select Outlook Data File 

c) Select Office Outlook Personal Folders File (.pst), and then click OK. 

 

Figure 14: Select File Type 

d) In the file creation box select a folder that will hold the new .pst file, type a name for the 

file, and then click OK. 

NOTE: Not every command allows users to have personal folders (.pst files) on 

network drives, so check with your organization.  The advantage of a personal folder on 

a network drive is that those files get backed up (and can be restored).  The disadvantage of 

network .pst files is that they can become corrupted.  Microsoft doesn’t support them.  

Experience shows that network .pst files typically become corrupted when they get 
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over 2GB.  If you choose to use network .pst files, you must pay attention to the file size 

(and add more .pst files as necessary). 

 

Figure 15: File Location 

e) In the Name box, type a display name for the .pst folder. 

 

Figure 16: Provide Display Name 

f) If you want to protect your data file by setting a password, under Password, type your 

password in the Password and Verify Password text boxes then click OK. 

g) The new .pst will now appear in your list of folders. 



15 

 

Figure 17: New Folder in View 

h) Once the new .pst is created, you can move the email.  The best practice is to move 

all email older than 6 months.  

i) Select the email to move (individually or as a group of multiple emails), then right-click 

and select “Move to Folder”. 

 

Figure 18: Move to Folder 
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j) If you have email stored in various folders, you can move an entire folder into the new 

.pst.  This can be done by right-clicking on it and selecting “Move to Folder”. 

 

Figure 19: Moving an Entire Folder 
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4.2 How to Reduce your Mailbox Size in Office 2013 

Note:  For those users who have mail in the CommVault archive, the mailbox size that is being 

used for the size limit implementation does not count anything in CommVault. 

4.2.1  Identify Current Size of Mailbox  

The first step in reducing your mailbox size is to identify the current size of your email folders.  

To identify the sizes of those folders perform the following tasks. 

a) In Outlook 2013, click “File” 

  

Figure 20: Click on File 

b) On the Account Information window click on “Cleanup Tools”. 
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Figure 21: Select Cleanup Tools  

 

c) Click on “Mailbox Cleanup”. 
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Figure 22: Click Mailbox Cleanup 
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d) This will open the Mailbox Cleanup window, next click on “View Mailbox Size” 

 

Figure 23: Mailbox Clean Up 
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e) To identify the size of all folders, click on the “Server Data” tab and look at the Total 

Size line.  Notice that this includes all subfolders. This is important since the size of not 

only the top folder, but the subfolders as well will count against the limit. In particular, 

pay attention to the size of the Calendar, Deleted Items, Inbox, and Junk E-Mail. 

f) NOTE:  When Outlook is running in Cached mode, it will store copy the mailbox in the 

locally stored OST file, for offline access. Sometimes, deleting / moving emails 

doesn't get sync'd with the server. So, your local data may look bigger (or smaller) 

than the server data.  You want to focus on the SERVER DATA because this is 

what mailbox size limit is calculated from. 

 

Figure 24: Total Size of Mailbox (Including Sub-Folders) 

g) In the picture above,the size of the inbox is provided in KBs (kilobytes).  Business class 

users have a 4GB (gigabyte) limit, so the total size must be less than 4,000,000 KBs.  

Basic class users have a 512MB limit, and the total size must be less than 512,000 KBs.    

IMPORTANT NOTE:  Each Outlook user is allowed to keep and store an unlimited amount of 

email, however it cannot all be stored in your mailbox.  Each user must make an assessment of 

which email must be “globally accessible” and which email only need to be accessible from the 

primary work location (i.e. the office).  Just like you can have an unlimited amount of clothing 

stored at in closets at home, but only take a specific amount and type when travelling, you can 

have an unlimited amount of email stored and accessible from your office but must determine 

which email must be accessible via webmail or a mobile device so you can access it any time 

from any where.  Unlimited storage is covered in step 4.2.3 below. 
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4.2.2  Easy Mailbox Cleanup Tasks  

If the total size of the folders exceeds the mailbox limit, the user must proceed with clean up 

tasks.  Prior to creating any local storage files and moving oldest (rarely/never accessed) mail 

into those files, the user can perform some easy “house cleaning” by doing the following tasks: 

 Remove attachments from your calendar 

 Empty the Sent Items, Junk E-Mail, and Deleted Items folders.  

 Sort your Inbox by size, and clean up the largest items 

These steps will be covered in detail below. These activities in-and-of themselves may provide a 

significant change in folder size, especially if they contain large attachments. 

4.2.2.1 Remove attachments from your Calendar. 

a) The simplest way to clean attachments from your calendar is to view the Calendar as a 

list and then sort the Calendar by size.   

b) In the Outlook Calendar, select the "View" menu, then select "Change View” and select 

“List”. 

 

Figure 25: Change Calendar view to List 

c) If you don’t have the “Size” column, then click the "Add Columns" to open the Show 

Columns window. From here you can add extra columns to better organize the calendar list. 
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Figure 26: Adding the Size column 

d) Select "All Mail Fields" from the "Select available columns from" drop-down menu. A list 

of columns that you can add to the Outlook window appears. 

e) Click "Size" in the "Available columns" box, then click "Add." The "Size" column is added 

to the "Show these columns in this order" box. 

f) Click "OK". The "Size" column will appear in the Outlook Calendar window. 

g) Click the "Size" column to sort by the size of the items.  The largest items are moved to 

the top of the list.  You might have to click “Size” more than once to make it sort correctly.  You 

may have odd sorting caused by groups of recurrence, which means all the largest items won’t 

be at the top, but rather at the top of their group. 

h) Once the calendar appointments are sorted by size, you can open the largest 

appointments and review the attachments.  Save the attachments, if desired, by right-clicking 

the attachment and choosing “Save As” and then selecting the location to save the file and 
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clicking “Save”.  Whether you save the attachment or not, delete the attachments from the 

appointment and click “Save and Close”. 

4.2.2.2 Empty Sent Items, Junk E-Mail, and Deleted Items folders.  

a) The first step in this process is to open the Sent Items folder in the left hand panel of 

Outlook as depicted below. 

  

Figure 27: Open Sent Items 
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b) This will populate the center panel with emails contained in this folder.  To delete all 

these items, select the top email (click once), hold the <Shift> key, then scroll down to the 

bottom of the window and click on the bottom email.  This should highlight the entire grouping of 

emails as shown below. 

  

Figure 28: Select Entire Group for Deletion 

c) Delete this group by pressing the <Delete> key.  If you only want to delete some of 

the items, then simply select the ones to eliminate and delete those. 

d) Repeat this same process for the Junk E-Mail folder. 

e) Lastly, repeat this process for the Deleted Items folder.  NOTE: Emails deleted from 

the Sent Items and Junk E-mail folders will be placed in the Deleted Items folder thus it is import 

to clean out the Deleted Items folder last. 

f) With these folders cleaned up the user can check the updated size of the mailbox by 

simply clicking on “Tools”, “Mailbox Cleanup…” and “View Mailbox Size…”. 
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4.2.2.3 Sort your Inbox by size, and clean up the largest items 

a) If the Size column is available in your Outlook Inbox, sort the Inbox by clicking the 

Size column header.  The direction of the little triangle indicates largest to smallest or smallest-

to-largest.  See Figure 24 below. 

 

Figure 29: Sort Inbox by size 

b) Once the email is sorted by size, you can delete any email you no longer need. 

c) For email you want to keep, open the email and review the attachments.  Save the 

attachments, if desired, by right-clicking the attachment and choosing “Save As” and then 

selecting the location to save the file and clicking “Save”. 

 

Figure 30: Save Attachment using “Save As” 
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d) Whether you save the attachment or not, remove attachments from the message 

using “Remove Attachment” (in either the attachment toolbar or by right-clicking on the 

attachment). 

 

Figure 31: Sort Inbox by size 

e) Once attachments are removed, click the “X” in the top right corner of message to 

close.  Click “Yes” to save the changes. 

f) If you don't want to keep the email but need the attachments, open the email and 

save the attachments.  Right-click the attachment and save, then delete the message. 

g) Once attachments are saved and unnecessary email deleted, remember to go back 

and empty the Deleted Items folder (because email deleted from the Inbox is now in your 

Deleted Items folder). 

4.2.3  Create an Outlook .pst file 

If after the Calendar, Sent Items, Junk E-Mail, and Deleted Items folders have been cleaned 

out, and the mailbox is still over the size limit, then the user can leverage the use of .pst files 

(personal folders) to store an unlimited amount of email locally. 

IMPORTANT NOTE:  Each Outlook user is allowed to keep and store an unlimited amount of 

email, however it cannot all be stored in your mailbox.  Each user must make an assessment of 

which email must be “globally accessible” and which email only needs to be “locally accessible” 

from the primary work location (i.e. the office).  Just like you can have an unlimited amount of 

clothing stored in closets at home, but only take a specific amount and type when travelling, you 

can have an unlimited amount of email stored and accessible from your office but must 

determine which email must be accessible via webmail or a mobile device so you can access it 

any time from any where.  To clarify this concept, your mailbox is your suitcase and your 

personal folders (.pst files) are your home closets (and can be located on local drives or shared 

drives). 
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According to email usage statistics, most people very rarely access anything over 6 months old.  

The best business practice is to move email older than 6 months into a personal folder.  This 

does three important functions: 

 It keeps the user’s most important email globally accessible, while still retaining all email 

and making it all available when in the primary work place. 

 It keeps the Outlook mailbox trimmed and manageable, resulting in fast and responsive 

performance for the user. 

 It provides an easy option for a user to retain/save all email the user wants to keep for 

an indefinite period of time. 

To continue with this process follow the steps as described below: 

If after the Sent Items, Junk E-Mail, and Deleted Items folders have been cleaned out, and the 

mailbox size is still over the prescribed 4 GB limit the user can leverage the use of.pst files to 

store emails locally.  To continue with this process follow the steps as described below: 

a) In Outlook 2013, click “File” 

  

Figure 32: Select File 
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b) Click on  “Account Settings” box and then “Account Settings” again 

  

Figure 33: Account Settings 

c) In the Account Settings window click on “Data Files” 

 

Figure 34: Data Files 
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d) Click on “Add” to add a new data file. 

 

Figure 35: Add Data File 
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e) In the Create or Open Outlook Data File window, select a folder that will hold the new 

.pst file, type a name for the file, and then click OK. 

NOTE: Not every command allows users to have personal folders (.pst files) on network 

drives, so check with your organization.  The advantage of a personal folder on a network 

drive is that those files get backed up (and can be restored).  The disadvantage of network .pst 

files is that they can become corrupted.  Microsoft doesn’t support them.  Experience shows 

that network .pst files typically become corrupted when they get over 2GB.  If you choose 

to use network .pst files, you must pay attention to the file size (and add more .pst files as 

necessary).   

 

Figure 36: Name the Data File 
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f) Once the data file is created, it will appear in the Outlook list of folders.  

 

Figure 37: New Personal Folder in Outlook List of Folders 

g) Once the new personal folder (.pst file) is created, you can move the email.  The 

best practice is to move all email older than 6 months. 

h) Select the email to move (individually or as a group of multiple emails), then right-

click and select "Move”and then select the desired folder. 

 

Figure 38: Move to Folder 
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i) If you have email stored in various folders, you can move an entire folder into the 

new .pst.  This can be done by right-clicking on it and selecting “Move Folder”. 

 

Figure 39: Moving an entire Folder 

j) Once you select “Move Folder” a window will open to identify the destination of the 

folder.  Select the location and click OK. 

 

Figure 40: Selecting destination for entire folder 
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4.3 How to Reduce the Mailbox Size in Outlook Web Application (OWA) 

IMPORTANT NOTE: OWA does not provide the same functionality as Outlook.  The limited 

functionality does not allow the removal of attachments from messages or calendar items.  You 

can save attachments and then delete the entire message or calendar item.  There is no option 

to remove the attachment and save the message/item. 

If possible, email cleanup should be done through Outlook.  Outlook Web App has few features 

that support saving or filing messages/calendar items.  The best practice is to delete 

unneeded messages as soon as possible and practice ongoing maintenance. 

ADDITIONAL NOTE:  For those users who have mail in the CommVault archive, the mailbox 

size that is being used for the size limit implementation does not count anything in CommVault. 

4.3.1  Identify Current Size of Mailbox in OWA 

The first step in reducing the mailbox size is to identify the current size. 

a) In OWA, hover the mouse cursor over your display name in the upper-left corner.  This 

will display the amount of space used, and the total mailbox size. 

  

Figure 41: Mailbox Size in OWA 

b) Notice in the above image that not only is the size of the mailbox displayed but also the 

limitation of the mailbox.  In this case, the limit is 512MB as this user is a basic class 

user.  If the user is a business class user the size limit is 4GB. 

4.3.2  Easy Mailbox Cleanup Tasks in OWA 

If the size of the mailbox exceeds the mailbox limit, the user must proceed with clean up tasks.  

Prior to creating any local storage files and moving oldest (rarely/never accessed) mail into 

those files, the user can perform some easy “house cleaning” by doing the following tasks: 
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 Remove items from your calendar 

 Empty the Sent Items, Junk E-Mail, and Deleted Items folders.  

 Sort your Inbox by size, and clean up the largest items 

These steps will be covered in detail below. These activities in-and-of themselves may provide a 

significant change in folder size, especially if they contain large attachments. 

4.3.2.1 Remove items from your Calendar. 

In your calendar, select the item you no longer need, and click “Delete” (or press the 

<Delete> key). 

 

Figure 42: Delete a Calendar item in OWA 

4.3.2.2 Empty Sent Items, Junk E-Mail, and Deleted Items folders. 

If these folders do not contain information of any consequence, then all the contents (of these 

folders) can be deleted. 

a) The first step is to click “Sent 

Items” in the left hand panel of 

OWA. 

b) If you only want to delete some of 

the items, then simply select the 

ones to eliminate and delete those 

using the <Delete> key. 

c) To delete all the items in “Sent 

Items”, right-click on the “Sent 

Items folder and in the drop down 

window Click on “Empty Folder”. 

  Figure 43: Empty Sent Items 
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d) Click “Yes” when asked to verify deletion. 

 

Figure 44: Verify Deletion 

e) Repeat this same process for the Junk E-Mail folder. 

f) Lastly, repeat this process for the Deleted Items folder.  NOTE: Emails deleted from the 

Sent Items and Junk E-mail folders will be placed in the Deleted Items folder thus it is 

import to clean out the Deleted Items folder last. 

g) With these folders cleaned up the user can check the updated size of the mailbox by 

simply clicking on "Tools", "Mailbox Cleanup…" and "View Mailbox Size…". 

4.3.2.3 Sort your Inbox by size, and clean up the largest items 

If after the Sent Items, Junk E-Mail and Deleted Items folders have been cleaned out, and the 

mailbox size is still over the limit, the user will need to continue with cleanup tasks.  The next 

step is to save attachments that may be needed later and then delete the message. 

a) Before we start saving attachments (and then deleting the email), it is usually best to sort 

by size and work on the largest messages first.  At the top of the Inbox, select “Arrange 

by” and then choose “Size”.  You may also sort by another parameter, i.e. From or 

Attachments. 

 

Figure 45: Sort by Size 
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b) Once the email is sorted by size, you can delete any email you no longer need. 

 

Figure 46: Mail Sorted by Size, Largest on Top 

c) If there are attachments you need to keep, you can save the attachment and then delete 

the email. 

d) To save an attachment locally from within OWA, simply open the email, right-click the 

attachment, and choose “Save target as”. 

 

Figure 47: Save an Attachment 

e) Select the location to save the file and click “Save”. 
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f) Once you have saved the attachment, select the “X” (Delete) from the toolbar. 

 

Figure 48: Delete the email 

 

4.3.3  Options for “saving” (and removing) email from OWA 

The limited functionality of OWA does not allow saving email into personal folders (.pst files).  

The only way to save email from OWA is to remove the email from the OWA mailbox by either 

forwarding to a personal account, saving as a document (Microsoft Word, WordPad, Notepad, 

OneNote, WordPerfect, etc.) or Adobe PDF (.pdf file).  The methods provided below store the 

content of the email before deleting the message. 

4.3.3.1 Forwarding individual email in OWA 

One method of “saving” an email from your DEE account is to forward it to a personal account, 

and then delete it from DEE.  WARNING – Forwarding to a personal account is only authorized 

for personal email, not for Official Use Only email. 

a) To forward an individual email in OWA, click the blue “Forward” arrow. 
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Figure 49: Forward Email in OWA 

b) Once the Forwarding window has opened, enter the recipient's email address, and click 

“Send”. 

4.3.3.2 Saving email as a document  

There are two options in OWA for saving email in other formats.  The first is to copy and paste 

the contents of the email into preferred document format and the second is to save as a .pdf file. 

a) To save an email using the copy-n-paste method into a document: 

1) Open the email. 

2) Highlight the Subject, Sender, and Date information by placing the mouse in the 

upper left corner of the email, click and drag the mouse to  the lower right corner,  to 

the date of the email, then press <CTRL> + <C> (or right-click and select “Copy”) to 

copy the highlighted area and place it on the clipboard.  (NOTE: The section 

containing body must be copied and pasted separately.). 
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Figure 50: Copy from OWA 

3) Next open Microsoft Word, WordPad, Notepad, OneNote, WordPerfect, or any; other 

document editor and paste the email header info by clicking in the document and 

pressing <CTRL> + <V> (or right-click and select “Paste”). 

 

Figure 51: Paste email in OWA 

4) As shown above, everything you highlighted is copied but some of the extra HTML 

details will be also be captured using this method.  Those extra details (such as the 

empty box and the row “M” shown above) can be deleted. 

5) Next, using the same copy-n-paste method, highlight the body of the email and copy 

then paste the data into the destination document. 
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Figure 52: Copy Body of Email 

 

Figure 53: Paste Body of Message 

6) After pasting the data, save the document to a desired location. 

7) Once the document is saved, delete the message in OWA. 
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b) To save an email as a PDF: 

NOTE: This technique is dependent on the options you have on your computer.  Not everyone 

will be able to “print” as an Adobe PDF, but many people do have the capability. 

1) Open the email in OWA. 

2) Click on the printer icon in the upper middle part of the window. 

 

Figure 54: Click on Print Icon 

3) Within the print window move the slide bar all of the way to the left until the “Adobe 

PDF” selection is visible and then select it. 

 

Figure 55: Select Adobe PDF printer 
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4) Next click on Print button and then within the “Save PDF File As” window select a 

location and name for the file. 

 

Figure 56: Save File as PDF 

5) Click the “Save” button. 

6) After saving, Adobe Acrobat will open the file for viewing. 

 

Figure 57: PDF File Opened in Adobe Acrobat 

7) Click the “X” in the top right corner of Adobe to close. 

8) Once the PDF is saved, delete the message in OWA. 


